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Chapter 3
UCS, Viewports and Wireframe Modeling

_ ™

Ojeeiives

¢ Understand the Use of UCS on More
Complex Designs

¢ Display and Orient 3D Views

¢ Apply and Expand the Basic Wireframe
Construction Techniques

¢ Use Additional Tools to Assist the
Creation of 3D Wireframe Models

¢ Use the Named Views Option
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Introduction

In the previous chapter, we examined some of the basic techniques to create 3D
wireframe models. Again, a wireframe model is a skeletal description of a 3D object.
There are no surfaces in a wireframe model; it consists only of points, lines, and curves
that describe the edges of the object.

In this chapter, we will further discuss the techniques and wireframe modeling tools
available in AutoCAD. Instead of creating the corners and edges of wireframe models by
entering the precise 3D coordinates, the use of construction lines and referencing
techniques are illustrated. The construction of edges in 3D space can be simplified by
using the AutoCAD User Coordinate System. We will also use the multiple viewports
option, which is available in most CAD systems, to aid the construction of 3D wireframe
models.

It is important to point out that most of the construction tools used in creating 2D designs,

such as Object Snap and Polar Tracking, as well as the Copy, Mirror, and Array
commands, are also applicable to the constructions of 3D wireframe models.

The V-Block Design
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Starting Up AutoCAD 2023

1.

Select the AutoCAD 2023 option on the Program menu or select the AutoCAD
2023 icon on the Desktop.

All apps

I
-

Attach Digital Signatures

AutﬂCADﬁ]EB - English
Mew

Batch Standards Checker
Export AutoCAD 2023 Settings

Import AutoCAD 2023 Settings

2. In the Startup window, select Start from Scratch.

3. In the Default Settings section, pick Imperial (feet and inches) as the drawing

units.

ok

3D Modeling Workspace

{553D Basics -5
Drafting & Annotation odify
3D Basics
3D Modelingh l.f'f
| Save Current 3D Modeling

Workspace S

Press F1 for more help
Customize... I

4. Pick OK in the Startup dialog box to accept the selected settings.

1. Click on the workspaces list in the Quick Access
toolbar and choose to use the 3D Modeling
workspace as shown.

2. On your own, switch on the Menu Bar.

» Notice the different 3D modeling toolbars
available in the Ribbon toolbar area as shown.

Dm o HEL e s

-4 3D Modeling

Home

Modeling * Mesh ¥ Solid Editing * Draw ™

fart  Deawinal* % b

/= 4 share

Solid  Surface Mesh Visualize Parametric Insert Annotate  View

Wodify *

0, 2 signin e & @- |

Manage Output Add-ins Collaborate  Express Tools  Featured Apps L

Drawing1.dwg

b | Type a keyword or phrase

D !I (1] @ @ PEEP- oL e BT C@ 15 - 18 to, 12 1@ 2D wireframe ~ @ i @ [gJ
i - @ O AV - (B @& AR SRR R e . - L = l_l—_l
Box  Extrude s Smooth ek ) @ & o R ‘Du Section L 18 1 12 1, | Bunsaved View Culling| Mo Filter ~ Move | Layers | Groups = View
y g obet @ & @i- OG- 4 ARl €8 pane 12 ®word 0 - Gimo

Section ¥ ¥ Coordinates View ™ Selection - - -
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Layers Setup
1. Inthe Menu Bar, sclect [Tools] 2> [Toolbars] > [AutoCAD] > [Layers].

Tools Draw  Dimension Modify  Window  Help  Parame 3D Navigation
Workspaces > Fe Output  Colla Array Edit
¢ Palettes > = te . t Array_Toolbar
[ Toolbars > AutoCAD > CAD Standards
{! Command Line Ctrl+9 Section A Camera Adjustment
b Clean Screen Ctrl+0 Plane I Dimension
" %% Spelling ection ~ ¥ Co Dimensional Constraints
K= Quick Select.. s
Draw Order > Draw Order
Isolate 3 Draw Order, Annotation to Front
Inquiry 3 Find Text
lA:_-i‘ Update Fields Geometric Constraint
. Group
[ Block Editor Inquiry
Xref and Block In-place Editing > Insert
E‘E Data Extraction... Layers
Data Links > Lakrs M
& - 1 - i |
ss-—f@%.-,-._'_‘?lo . _ .
2. Click Layer Properties Manager in the
(=] Layer Properties Manager Layers toolbar.

% In AutoCAD, we always construct entities on a layer. It may be the default layer or a
layer that we create. Each layer has associated properties such as the visibility setting,
color, linetype, lineweight, and plot style.

‘:& == = 4 3. Click on the New Layer button. Notice a layer is
automatically added to the list of layers.

v New Layer (Alt+N)

4. Create two new layers with the following settings:

Layer Color Linetype Lineweight
Construction Grey Continuous  Default
Object Cyan Continuous  0.30mm

5. Highlight the layer Construction in the list of layers.

G G SR 6. Click on the Set Current icon to set layer Construction
s N gg . . as the Current Layer.
ame
:| = 0 | Set Current |
’ﬁ} 7. Click on the Close button to accept the settings and
y¢§ Current layer: Const exit the Layer Properties Manager dialog box.
F3 B 44
Sl !& F;.Iters « 8. In the Status Bar area, turn ON the Grid Display, Polar
Tracking, Object Snap, Object Snap Tracking, Dynamic
B2 All Input and Lineweight options.
- C5 All Used
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Create the Rectangular Base of the Design

We will first use construction geometry to define the outer edges of the design.

¢ i loO

2 © L gf' M Object

£ '.-:. L7 o’ B Construction 1. Inthe Layer Control box,

confirm that layer

1 & ¢ T of -
s LN |Construction Construction is set as the

Current Layer.

bols Draw Dimension I

rametric  Insert  Annotate
FD A T e & 4H
SO &

210, '|:|x ORIy W

Rectangle

Creates a rectangular

2. Select the Rectangle icon in the Draw toolbar. In the
command prompt area, the message “Specify first corner
point or [Chamfer/Elevation/Fillet/ Thickness/ Width]:”
is displayed.

3. Place the first corner point of the rectangle near the
lower left corner of the screen. Do not be overly
concerned about the actual coordinates of the location;
the drawing space is as big as you can imagine.

4. We will create a 3" x 2" rectangle by entering the coordinates of the second corner
using the relative coordinates input method.
Specify other corner point or [Dimension]: @3,2 [ENTER].

TEE IEDWireframe - g
ta, |Unsa1.red"u"iew v_| c
- @Tap
Hl@Buttnm |
] Left
(o Right
"._jFrn:nnt
gBack

i3 SW Isometric
K‘tﬁ SE Isomgtric |

€ NEIsnrrJrESEI -
SOMELrC
€2 NW Isl:urr[

View Manager...

ele

5. Inthe View panel, select:
[Unsaved View] - [SE Isometric]

e Notice the orientation of the sketched 2D rectangle in
relation to the displayed AutoCAD user coordinate
system. By default, the 2D sketch-plane is aligned to
the XY plane of the world coordinate system.
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Create a Wireframe Box

Next, we will use the Copy command to define the 3D boundary of the design.

mension  Modify  Window

Annotate  View  Manage
R

B @& C Copy
A bl ¢ Copies objects 3
Modify :

1. Click on the Copy Object icon in the Modify toolbar.

2. In the command prompt area, the message “Select
objects:” is displayed. Pick any edge of the sketched
rectangle.

Inside the graphics window, right-click once to accept
the selection.

In the command prompt area, the message “Specify base point or displacement, or
[Multiple]: is displayed. Pick any corner of the sketched rectangle as a base point to

create the copy.

In the command prompt area, the message “Specify second point of displacement or
<use first point as displacement>:” is displayed.
Enter @0,0,2.25 [ENTER].

Note that the three values represent the distance measured in the X, Y and Z
directions relative to the current UCS.

e,

6.

v

B |

I

v | Zoom bxtents
Zoom Window
Zoom Previous

Zoom Realtime

Zoom All I::z?

=z ™

Use the Zoom All command, in the View Display toolbar, to
adjust the display.

On your own, use the Line command to create the four lines
connecting the four-corners of the two rectangles as shown.

pls

™
[

~J
(753

Draw Dimension Mod

Bmetric  Insert  Annotate
DA T oA

@ - @®C

Wi

A

| Line

Dr ; ;
Creates straiaht line seat
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Using the View and UCS Toolbars

1. Inthe Menu Bar, select [Tools] = [Toolbars] = [AutoCAD].
Tools Draw  Dimension  Modify Window  Help  Param
Workspaces >
Palettes > Ik [
Toolbars > AutoCAly >
| Command Line Cirl+9 Move Offset Cop
Clean Screen Ctrl+0 ’
| ¥
ucs
ucsill . . . .
v 2. Select View, with the left-mouse-button, to display the View
oW % toolbar on the screen.
Viewports
Visual Styles
Walk and Flv
Text 3. Move the cursor to the Standard toolbar area and right-click
ucs on any icon of the Standard toolbar to display a list of toolbar
ucs i menu groups.
| View 4. Select UCS I, with the left-mouse-button, to display the
Viewports UCSII toolbar on the screen.
» The options available in UCS II toolbar allow us to quickly align the UCS to the
preset standard 2D views.
i = - X -
i, 19|18 word 5. Note that the current UCS is aligned to the
?_ World World Coordinate System. Select Front in
b ?re‘”ous the UCS II toolbar as shown.
op
@ Bottom
(o
g Back
7] Left
E’E Rnght [-1ISE ometric]I2D Wireframe] -
> Note that the UCS has been . A ~_ | . -
adjusted and it is now aligned | I S N
parallel to the front view of the : : NN
wireframe box as shown in the ' S ~No
figure. g
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Create Construction Lines in the Front View

1.

Is Draw Dimension Mo
pmetric  Insert  Annotate |
DL T -th AP
NAO B ®C
G
~ ] Line
= Temporary track point
p—
b From
Mid @e‘rween 2 Points
Point Filters >
3D Osnap >

Restrict cursor to specified
Polar Tracking (F10)

b G Y - [~ 3

3, 1T, I3, &0

Trackjr\q\Settings...

L [E]- W [

a Drafting Settings

Snap and Grid Polar Tracking  Object 4

B Polar Tracking On (F10)

Polar Angle Settings
Increment angle:

|3-I}

L |

] P@ﬂional angles

Select the Line command icon in the Draw toolbar. In
the command prompt area, the message “ line Specify
first point.” is displayed.

2.

Inside the graphics window, hold down the [SHIFT]
key and right-click once to bring up the Object Snap
shortcut menu.

Select the From option in the pop-up window.

Pick the lower right corner of the bottom horizontal
line in the front view as the base point.

In the command prompt area, the message “Specify
next point or [Undo]:” is displayed. Enter @0,0.75
[ENTER].

We will set up the Polar Tracking option to assist the
creation of the next corner. Right-click once on the
POLAR Tracking option located at the bottom of the
graphics window.

In the option menu, select Settings by clicking once
with the left-mouse-button.

8. Inthe Drafting Settings dialog box, set the Polar
Increment Angle setting to 30 degrees.

a Drafting Settings

Snap and Grid  Polar Tracking ©Obj

[ Tl S NP L WO | i 11

Snap

9. Click on the Object Snap tab to switch to the
Object Snap option settings.
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a Drafting Settings
Snap and Grid  Polar Tracking Obiject Snap 3D Object Snap  Dynamic Input .
o o 10. Confirm that the Intersection and

Object Snap On (F3 Object Snap Tracking On (F1 . . .

piect Snap On (73 foct Snap Tracking O Extension options are switched ON as

Object Snap modes h
[0 @ Endpoint - (@ Exension Selef Shown.
2 [ Midpoint 4 [insertion Cled
v B Center b [ Pemendicular .
11. Click on the OK button to accept the
[ Geometric Center T [ Tangent .
Settlngs.

& (JNode % [ MNearest
<» [ Quadrant E [ Apparent intersection
¢ (@ Intersection 4 [ Parallel [

O To track from an Osnap point, pause over the point while in a

" command. Atracking vector appears when you move the cursor.

L stop tracking. pause over the point again.

12. In the command prompt area, the
message “Specify next point or [Undo]:”
is displayed. Using the Polar Tracking
option (30 degrees increment), create a
line as shown in the figure.

13. Move the cursor near the left vertical ' - ~
edge of the front view and create the N N
second line perpendicular to the last . : - : ~~
line we created. ' ~ ' ' ' P

14. Inside the graphics window, right- | - NS -
click to activate the option menu and ' ‘ - :

.
select Enter with the left-mouse- : = SN “-
button to end the Line command. < U

Enter . . \\__\\ . S\ . //,/
Cance[l} ' BN ' e

Recent Input > . : |




3-10  AutoCAD 2023 Tutorial: 3D Modeling

Copy Objects in the Negative Z Direction

mension  Modify  Window |1 Click on the Copy Object icon in the Modify toolbar.
Annotate  View  Manage

o & 4 9% % - A 2. Inthe command prompt area, the message “Select
L objects:” is displayed. Pick the two edges we just
& ®C created

| Copy :
J AR

Copies objects| . . . . .
Modify : g 3. Inside the graphics window, right-click once to accept

the selection.

4. In the command prompt area, the message “Specify base point or displacement, or
[Multiple]:” is displayed. Pick any corner of the wireframe model to use as a base
point to create the copy.

5. In the command prompt area, the message “Specify second point of displacement or
<use first point as displacement>:" is displayed.

Enter @0,0,-2.0 [ENTER].

6. Note that the negative value represents the distance measured in the negative Z
direction relative to the current UCS.

7. On your own, create three lines to connect the corners of the two sets of lines we just
created, as shown below.

[—1ISE Isometric ][ 2D Wireframe] T T,
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Create an Inclined Line at the Base of the Model

it 18 | (7 Top ~ X[ 1. Select Top in the UCS II toolbar as shown.

s Draw  Dimension Mo 2. Select the Line command icon in the Draw toolbar. In

the command prompt area, the message “ [line Specify
DA T AP first point.” is displayed.

NAO- @ B
P B & ®C 3. Inside the graphics window, hold down the [SHIFT] key
Y Line and right-click once to bring up the Object Snap
shortcut menu.

kmetric  Insert Annotate |

= Temporary track point
-
b Fr-::-m@e

M'_d _tween 2 Points 4. Select the From option in the pop-up window.

Point Filters >

3D Osnap >

_ ' _ 7| 5. Pick the lower right corner of the bottom horizontal line
5 _ e as the base point as shown in the figure.
>E _ ' 6. We will place the first point above the selected corner.
Enter @0,0.75 [ENTER].

7. In the command prompt area, the message “Specify next
point or [Undo]:” is displayed. Using the Polar Tracking
option (30 degrees increment), create a line as shown in
the figure.

[-1ISE Isometric ]| 2D Wireframe] iy e

8. Inside the graphics window, right- A A N
click to activate the option menu : ol A -
and select Enter with the left- N e
mouse-button to end the Line ' ]
command. I

Enter : : SR N
% . LT . . . .\‘.' . ;)(\ .
Cance . N . Vo T T

Recent Input
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» On your own, use the Copy and Line commands to create additional edges so that the
wireframe model appears as shown below.

[-]ISE sometric ]|2D Wireframe] f;"’“mm
- ",
. __.-"'""’F-' KHH.‘“‘\-\
-
,-"-'/H Hw\"m
- "
-, :_;q
s . e —— -
H‘mx ] — F,-'"' \\H“‘mh
H:\HH -__-'_‘..-"" .__‘__,.-ﬂ"' . "'..'\ “uh:,
S, -
/}{:H ’-H____.-' "".!!f.___.-a""f
-~ -~
____.f"":-d HH"‘AH ‘__.-"'F-' ) .-'"f Y
-~ — 31::—-' .-""f l'-.
- e — — ! ] %
"__ .-'"“H""-x 1"":___ - y
- . i, - ".‘I
-____.J '.‘I"'\-.H g™ N
\ \
__.-"'}’ﬁ/ . I"'. H‘H”“ I'\.
. L1
___,,-"":-J ! H"\.H W
-___:_.-" l"l. ] ]
‘:.-' "., e, -
H‘m\_\ 1 T
HH“"H "I"-. ,-"’f’}&h‘xn
S, Ly | et
z "mh ‘.I. ___,.-'"' .___.‘:’
T Y I v e
-
. HH\'HH __f-"'ﬁ
s . _— r""
X <[
o -
N
Create Object Lines
N B - . .
L 25| @ @ L] o W construction 1. On the Object Properties toolbar, choose
[-1IC & iy TF

Object

the Layer Control box with the left-mouse-
button.

2. Move the cursor over the name of layer
bls

Draw

Object; the tool tip “Object” appears.

Moaodq
Insert  Annotate
A

3. Left-click once on the layer name; now layer Object is set as the Current Layer.
Dimension
pmetric N

Rl IR
i~ /- {Ei] - l;'_) ;\@: C)
/_\ .

Line

4. Select the Line command icon in the Draw toolbar. In
the command prompt area, the message “ line Specify
first point.” is displayed.

Creates straiaht line seqi
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5. Pick the lower left corner of the bottom of the wireframe model as the starting point
and create the four line segments as shown.

[—1I5E Isometric J|2D Wireframe]

Fifth point \

First point N

X - | Second point

¢ Note that even though the UCS is aligned to the base plane of the model, the Object
Snap option enables us to select points on the front plane of the model.

» On your own, create three additional lines representing the edges of the inclined face
of the design as shown.

[—1ISE Isometric ]| 2D Wireframe] - T~
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Multiple Viewports
View Insert Format Tools Draw  Dimension Modify  Wind
‘r—— wrt Amotate  View Mand 1. Inthe Menu Bar, select:
I Regen T AP BY-
. T5 Regen Al b . le @ S [View] 2 [Viewports] >
I sl e B [4 Viewports]
Zoom b AF €88 - P
Pan >
. - Modify « .
@) steeringWheels > AutoCAD allows us to display
> ShowMotion = different VIEWS of the model
Orbit > EEE .
= oo g simultaneously. Only one
Walk and Fly > viewport is activated at one
T — R time. The viewport w1th the
Viewports B 52, Named Viewports.. dgrker border is the active
PR Named Views _ viewport. Move the cursor
L New Viewports... .. .
3D Views > : inside each viewport and
1 Viewport R .
(@] Create Camera L notice the different cursor-
Show Annotative Objects > 3 Viewports dlsplay inside the active
& Hide 4 Vieworts viewport.
Viicinl Sl & Polygonal Viewport

BRI E B

Top

Sets the view point to top

=% VIEW

2. Activate the top left viewport by left-clicking once

inside the viewport.

3. Select the Top view in the View toolbar to change

the display of the viewport.

4. On your own, repeat the above steps and use the Realtime Zoom command to set
and adjust the displays of the viewports as shown below.

I [ +11SE someétric ]| 20 Wireframe] ;_/,.- —
r/’ .

\

» Note that the displayed UCS icons at the lower left corner of each viewport
correspond to the orientation of the wireframe model in each viewport.
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Use the Mirror Command

1. Activate the top left viewport by left-clicking once inside the viewport.

2. Pre-select all the objects in the active viewport by using a selection window.

[+1TopH2D Wireframe] -

First corner /

‘ | | Second corner
E/

Inside the active viewport, right-click to bring up the pop-
up option menu and select the Quick Select option.

Y
X
Subobject Selection Filt
Quick Select... 3.
QuickiBic
(E\ | T |
A Quick Select

Applyto: |Currentselection

Objecttype: |Multiple

Properties: [cglor

Layer

Linetype
Linetype scale
Plot style
Lineweight
Transparency
Hyperlink

Operator: |=Equals

Value: |§Object

How to apply: bs

© Include in new selection set

(O Exclude from new selection set

[]Append to current selection set

Help

In the Quick Select dialog box, select
Layer from the Properties list.

Set the Value box to Object.
In the How to apply section, confirm the

Include in new selection set option
is selected.

Switch OFF the Append to current
selection set.

Click on the OK button to accept the
settings.

AutoCAD will now filter out objects
that are not on layer Object.
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Annotate  View Manage Output

NI IR S A f@ 1 9. Click on the Mirror icon in the Modify toolbar.

B ®C D o ] : o
s A Ee®-| pame |1 10. Inside the graphics window, hold down the [SHIFT]
o key and right-click once to bring up the Object

Section v
Snap shortcut menu.
B8 9 8 4
E B ] e o . . . .
b = D eror 11. Select the Midpoint option in the pop-up window.
IEGREANE N :
Y Creates a mirrored

1 Modify D/j Endpoint

7 Midpgint
[+1Tepll2D Wireframe] >< Interséttion

\< Apparent Intersect

12. Inside the active viewport, click on the left vertical line
of the wireframe model. With the Midpoint snap option,
the midpoint of the line is selected.

13. Move the cursor toward the
right vertical line in the active
viewport; left-click once when
the Intersection symbol is
displayed as shown.

14. In the command prompt area, the
message “Delete Source Objects?
[Yes/No] <N>:"is displayed.
Inside the graphics window, right-
click once to bring up the option
menu and select No to keep both
sets of objects.
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Turn Off the Construction Lines

1.

On the Object Properties toolbar, choose the Layer Control box with the left-mouse-

button.

20 g H Object

@ Lynl' WO

&% [l o m e
[ ! T_f O -

Turn a layer On or Off

View Insert Format Tools Dimension  Modify
| " Redraw sert  Annotate  View
1 - 0%
[ Regen s
L 5, Regen All S s
lté = [[:J ‘,@;’ 6 D—*_'-

Zoom .
b - ¢ AR E
Pan et

IZ@ SteeringWheels - odify ~
BF  showMotion
| Orbit 7 %

; Camera
Walk and Fly
Clean Screen \
Viewports EI%I Named Viewports...
= Naméd\flews... 1 New Viewports...
3D Views 1 Vigwport
(@) Create Camera 2 Viewports
Show Annotative Objects 3 Viewports

2. Move the cursor over the light-bulb icon for
layer Construction, left-click once, and notice the
icon color is changed to a gray tone color,
representing the layer (layer Construction) is
turned OFF.

In the Menu Bar, select:

[View] = [Viewports] 2>
[1 Viewport]

Viewports can also be used as a
way of checking the integrity of
the constructed 3D models. Feel
free to switch to multiple
viewports in the following
sections of this tutorial.

On your own, create the
additional object lines
connecting the two sets of objects
as shown below.
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Create a New UCS

» The V-cut feature of the

design is the last feature, and
perhaps the most difficult one,
to create in the CAD system.
Based on your knowledge of
modeling with AutoCAD,
how would you create this
feature? What are the more
difficult aspects of creating
this feature?

Besides using the preset UCS planes, AutoCAD also allows us to change our viewpoint
and create new UCS planes. We will create a UCS plane aligning to the inclined plane of

the design.

Display Image > I I
New UCS > 1® World
1E Named UCS.. 1% Previous

@ Geographic Location... Ti', Face
CAD Standards > 19, Object
Wizards > 10 view

.. Drafting Settings.. fx, Origin

5] Group tz, z Axs Vector

.

8% Ungroup TE, 3 Point
Tablet 2

toex

A

-

Intersection

1.

In the Menu Bar, select:
[Tools] > [New UCS] >
[3 Point]

Note that other options are also
available to aid in the creation
of new UCS planes.

2. In the command prompt area, the message
“Specify New Origin point <0,0,0>:” is
displayed. Pick the lower-left corner of the
inclined plane as shown.
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|

Intersection

4. In the command prompt area, the
message “Specify point on positive
portion of X-axis:” is displayed. Pick the
top left corner of the inclined plane as

In the command prompt area, the message
“Specify point on positive portion of X-axis:”
is displayed. Pick the lower right corner of
the inclined plane as shown.

shown.
>~ ]
Pl
> UGS Icon > B+ on 5. In the Menu Bar, select
ViewCube > v Origin
Attribute Display > @' Pmpﬁrties_ [VIeW] > [Dlsplay] >
(@] Cameras "" [UCS Icon] = [Properties]
£ Lights
E| Navigation Bar
=] Text Window Ctrl+F2 B ucs icon
\ e
LICS ican style
6. Inthe UCS Icon window, switch the UCS icon style to O
2D as shown. O 3& T——

7. Click on the OK button to
accept the settings.
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Create a New Named View

Besides using the preset views, AutoCAD also allows us to change our viewpoint and
create new views, which can be saved and restored by name for convenient access. We
will create a new view aligned to the new UCS plane we just created.

1. Inthe Menu Bar, select
[View] - [3D Views] -2 [Plan View] > [Current UCS].

Viewpaorts >
I Named Views... /\
3D Views > 1® Viewpoint Presets...
(@] Create Camera Tﬁ Viewpoint
Show Annotative Objects > Plan View > [E Current UCS
_ 2!
@ Hide @ Top -E Worla UCS
Visual Styles > (& Bottom = Named UGS
Render > Q Left

e The graphics window is now adjusted to display the current UCS plane.

I«_%%@ i 0 ¢4 | 2. Click on the Named Views

icon in the View toolbar.

X ) ) Named Views...

3. Inthe View dialog box, click on the New button to
create a new named view.

¥ Set Current

[ e |
Lz

Update Layers

ﬂ Mew View f Shot Properties
4. Inthe New View dialog box, enter

View name: Aundliary Auxiliary as the new View name and
confirm the Current display option. In
the View Properties list, set the Save
View type: <l layer Snapshot with view option to
ON and the UCS option as Unnamed.

View category: <Mone=

Boundary

© Current display + 5. Click on the OK button to accept the
() Define window settings and create the named view.
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6. In the View dialog box, the new named view (Auxiliary) is added to the Named Views
list. Note that we can always switch to this view by using the Set Current option.

ﬂ View Manager

Current View: Current
Views

Q Current

E| [ Model Views
IR Awiliary
@ Layout Views
---LCI: Preset Views

General
MName
Category
ucs
Layer snaps...
Annotation...
Visual Style
Background...
Live Section

Animation

View type

Auxiliary
<Mone>
Unnamed
Yes

2D Wireframe

<MNone>

<MNone>

Cancel

Set rrent
MNew...
Update Layers
Edit Boundaries...

Delete

Apply Help

X

7. Click on the OK button to accept the settings.

|
BOPEHIDB GG O«

SE Isometric

Isometric View.

8. 1In the View toolbar, select SE
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Create the V-Cut Feature on the Inclined Plane

1. On your own, create two lines that are 0.2"” away from the top corners of the model,
which are also rotated 45 degrees relative to the top edge of the model.

6. Second Point

——

a

5. Base Point

mension  Modify  Window

Annotate  View  Manage

A DY

A r-\_J l/-f

5 Oy

£ ARl Copies objects
Modify

Click on the Copy Object icon in the Modify toolbar.

In the command prompt area, the message “Select
objects:” is displayed. Pick the two inclined lines we
just created.

Inside the graphics window, right-click once to accept
the selections.

5. In the command prompt area, the message “Specify base point or displacement, or
[Multiple]: is displayed. Pick the top left corner as the base point to create the

copy.

6. In the command prompt area, the message
“Specify second point of displacement or
<use first point as displacement>:" is
displayed. Pick the corresponding corner
on the backside of the model as shown in
the above figure.

7. On your own, create addition lines to
define the edges of the V-cut and use the
Trim command to complete the model as
shown.
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BOPEORBO

Front

8.

Click on the Front View icon in the View
toolbar.

hd

» Note that the V-cut we
created, using the Copy
command, does not represent
a cut that passes through the
entire block.

.

Extend the Cut and GRIP Editing

e &4 Y-

/ALl E

mension  Maodify  Window  Help
Annotate  View Manage QOutpy

l"——’ [:@:j C) D:— _%;Trim Jcm

Modify + _—"‘ end v
Extend

=]

e

1.

Select the Extend command icon in the Modify
toolbar.

2. The message “Select object to Extend or [Project/ Edge/ Undo]:” is displayed in the
command prompt area. Pick the bottom edge of the V-cut to extend.

Boundary
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3. Inside the graphics window, right-click to activate the option menu and select Enter
with the left-mouse-button to end the Extend command.

el s il ) é& € @ € |@| 4. Click on the SW Isometric View

icon to reset the display to the preset
SW Isometric 1sometric view.

5. Pre-select the top edge of the V-block as shown.

6. Left-click once on the lower right grip point on the
selected line.

e Selecting the grip points located at the end of the line or
arc allows us to STRETCH the selected line.

7. Move the cursor toward and select the lower corner of
the V-cut as shown.

» On your own, repeat the above steps and use the grip
editing options and complete the wireframe model as

Endpoint
£ shown below.

/- ﬁ\
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Review Questions:

1. List and describe three different types of 3D computer geometric modeling software
available today.

2. What is a Named View?

3. What is the difference between Stretch and Extend?

4. List and describe the methods available in AutoCAD to create a new UCS plane.
5. What is the difference between Copy and Mirror in AutoCAD?

6. Identify and describe the following commands:

a)

i
b)
c)

—f
d)

A
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Exercises: (Unless otherwise specified, dimensions are in inches.)

1.

473

6,50
~—130 3,50
100 — 100
4,00
1.00—
173
273
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